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. 9q 9 v 9y [~ @ -
Exception Aldvzdonsendoyailudaumniu
Condition :




dninvomyanans naseoMnmMMIANGSIK

M3197 3.2 A193U18V09 Use Case— U2 : Mimsouduninama Insdwiiioda luinmsdum

L

Use Case Name : | U2 : inmstudunmneaavInsdmsiiiveds luvimsAum
: 9q ¥ y v ¢ g Y A o A o Y
Trigger Event : Alansondeyanuemy Insdniudnazdoanmssuduineiinisdun
£
foyaini o 1eveInaneYTIY
[ { o [y o 1
Brief Description : | ¥aaa1nndldiinsnsenminaas Insdwiudrd1dezdoanatly Submit
A A o v ) S
eguiumMIAUmdoyavaIrNIay InsANNITY
[ 4
Actor : AldTasunsu Insdnniione
Related Use Case : | -
i yq ¥y ] A o I Yq Yo
Precondition : Alddosnisnsiwdeyamieaisusesnungay Insdwnigldiinisnsen
Y
A
o vq ¥ ] 5 Wk N3 Ao
Postcondition : Aldrzns ey Insawiiuilunietisle
Flow of Activity : | Actor System
1. {lgnatly Submit
1.1 szuuiinmsyszananadum
A 1 [ o
1A304 18I HNBIRY TNTANN
Y A [}
1.2 sEyyLaaIdoyanI o U
Y
N11190
Exception .
Condition :

117232
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Use Case Name :

o A 1 9 A ] = o o
U3 MN5nen192uayainiovu1gnsonnIuig

Trigger Event :

EY A 1

glddonsgdoyamiedrensodihinearsninmunany Tnsdnd

U

Brief Description :

@ ~ Y A ] @ J Y 9Yq Y
’HfN"l]'lﬂ‘Vl‘551J‘ULL?(@N511'03;1‘@Lﬂi'f)"U'IU"U'EJQTTlJ"IfJLﬁ"UTVIiﬁW‘V’ILla’J Al

U

v y oo ¥qy 9 0 A o
doan1sadoyadinneadsdldezasanaily Prophecy 1oIIN15LIEA
Y 0 =0’ = Y A Y

VDYAMNIUY Tay Prophecy ¥ 2 i1 19 U1 Tag Prophecy , Love
AZAW150AN Tag Operator iWoNa lulgdoyainTodovesnuisay

o gy
Tula

Actor :

A4 TusunsuInsdniidode

Related Use Case :

o Ay v
Uil ﬂi'f)ﬂWJJ'lEJLﬁ"UTﬂiﬁWVWlﬂﬂ\iﬂﬁﬂu‘Vﬂ

o A @ 1 s A 1 o Y
U Vnﬂﬁﬂuﬂuﬁﬁ']ﬂlﬁ‘lliﬂﬁi’fwwlwaﬁﬂhlﬂﬂ']ﬂ1§ﬂuﬂ']

Condition :

9o Y Y o | o A Y v 9/ “o%Emo @ Y
Precondition : chl“ﬁﬂﬂﬂﬂﬁﬂ"u’f)ﬂsl‘aﬂ'm']u”lfJ‘ﬁifJﬂfNﬂ'lﬁﬂﬁﬂ%']ﬂﬂu'lﬂ'l“Vﬂu‘]ﬂvlﬂfNﬁuW
Y A 1 @ 14
maxﬂmmsamwmmaﬂmﬁwm
N, yq ¥ & o o v &
Postcondition : @,%%mwmm'wmwmmwmmaﬂmﬂwwuu
Flow of Activity : | Actor System
L é}cl‘ls)’lﬂﬂﬂu Prophecy
o g o
1.1 IZVUMMIUANIUIVDY AN
Nuy
2. gldmwsadonndu )
9 Y A v
ﬂu']@ﬂ]ﬂyﬁlﬂiﬂ‘lﬂﬂiﬂﬂﬂ"ﬁﬂﬂ
Tag o Operator wagd
Y [ Y [ o
ﬂ@ﬂﬂﬁﬂﬁﬂ‘lﬂ‘ﬂu'l‘ﬁﬁﬂ m
1A8N13NALYN Main Page
2.1 i%UUﬁ1ﬂ1§Llﬁﬂ\1ﬂﬁ}1ﬂ1Mﬂﬁ
natjuvoeld
Exception =
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Use Case Name : U4 . @%’mgammmﬂm%ﬁﬁzﬁy
< yq Yy ) o da
Trigger Event : g“lwmmsmmmayjawmmaﬂmﬁwwmy
Brief Description : | #1¥d0in1imaumineavives ey iowimsasindeuimuiumy
a ~ q’;’ 9 = el g)
Ay nswiugndeanse Tl niedoanisez InsmluTnuavmomy
a 1 ] Y6 ¥ a d' ]
e lunsiwmnemy §ldawisatlagiiosislunisasnasuuaz
andulala
Actor : gl lsunsuInsdniiode
Related Use Case : | -
= Yq ¥y 9 i
Precondition : Aladoinisnsudoyarieay InsAwiniay
ey Jq 9 [ da Y [ da
Postcondition : Alansrwmnaay Insdwnivauiazdoyavesnuomy Insaninisy
E
Hu
Flow of Activity : | Actor System
% éjnl%ﬂﬂﬂn Special Number
1.1 szuimsuaaanidoya
nanoay Ins iy
Jq = ]
2. flFanansadonvuiany
[ da Y
Yonmeny Tnsannney1d
Tagn13naln Tag luiaviae
- : “
vyt Tagll 3 Muda Ao
Emergency , Food 1i& Service
2.1 szuuimsuaasdoyananemy
@ da U
InsAwn Ay LI NALjy Tag Vo9
Al
Exception -
Condition :
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Use Case Name :

A g v da & g
Us: LWNUﬁ@ﬂ‘I’TJJ'IULa‘UT‘V]'iﬂ‘WWV]ﬁSﬁTTuQUﬂ'EJﬂ

B A a3 v I 2 [
Lla53”1]%@\1["”517‘]1]1]31@ﬂﬁuqﬂlaMIﬂﬁﬁWﬂV]agﬁuQUa@ﬂ

Trigger Event : é}@
9 9 < LY -{ Vo g
Brief Description : Qq,uaizmmiaﬂsuaagauaaﬂwmmaﬂmﬁwﬂm IWDNINIT update
vy
Voyn
Actor : vj@umzuu
Related Use Case : | -
9/ yJ @ J ] o 4
Precondition : Q@,!Lﬁ§$Uﬂﬂ@\3ﬂ1§%ﬂﬂ'}i‘u'ﬂy‘ﬁ‘ﬂﬁ@ﬂﬁiﬂﬂlﬁ”lﬂ‘ﬂiﬂWﬂ
A 3 A I o 1
Tunsdimuszdumsimudeyauaonnuioma Insdwyi lmi doya
A [} 3 Y k4 z ) v g 9
Lﬂ’i@sll'lﬂsllﬂxi‘ijﬂﬂﬂﬂll'lf.lm"UT‘Vlii’fWﬂuu mmwmﬂugmmayja
v a g 3 v oy 4 Y\ da o
Postcondition : Q@,!Lﬁ'i$°lJU!Wll‘llf]qula‘]Jaf)ﬂ‘ViMTULﬁ‘UTVﬁﬁW‘l’I Volalninuy ﬂmgm“lu
S Y g & g v A g =
database €I VVADNHUNIQVUY INBUAPANUDUANYNADI LA W
v i Aa A gy o a A
VDYAMFTANUNIT update lWi’)cl‘Viﬂiﬂﬂ‘Uﬂ')']JJL‘ﬁu%‘NJﬂﬂWQﬂ
Flow of Activity : | Actor System

] TR Y]
1. fauaszuunaifuiudoya
gy Insfwe uaz

A 1)
1n50%Y

N A v
) Szummmtmuvhmwwuaga

Y

8 Q’@uaizuumaﬂﬂmua

U

[ J 9
NUAY INSANN Voua

U

Ty iy { 2 v g 9
INI0VY l!ﬂgﬂﬂ‘l‘!N submit 24 izummﬂum’ogaﬁmmm

Qi ]
Insfmnuazdoyainione

=

o [ I
2.2 SUUMUIUNUIORY TNTANNIN

v
=

nuavRIMIgazilo maiuen

Ao v A Y
ﬁ‘i\?ﬂ"lﬂla‘llﬂﬂ"lu’lmvlﬂ INDTEIN

anuduiusvesdoyariaanadiu
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A 3
2.3 sEUuMaas “iiudoyavaon

o I 9
neay InsAnNSsusoy”

Exception

Condition :

4 3 a A < o 5
ﬂ‘li’]\iﬁ 3.6 ADTU18VDY Use Case— U6 : LWﬂJUﬁi’)ﬂ‘ﬁNWﬂLaGIIT'VI'iﬁWVIﬁﬁgWa”IUHﬁ@ﬂélj'JEJ excel

e o =
Use Case Name : U6 : iilnpdenvinemy Insimniagnaisudendiy excel
v v 2 3 o g 3 )
Trigger Event : HauaszuIARIMSINNUaRNHIILE@Y INsAninaznatwudon A1ems
1 14
grudoyannlid excel
9 9 A gy I~ 1) o ; & %o
Brief Description : | HQIAs2UUADIMSIRNYDYaUaDNMIIB@Y INSANN 1ni tNo1i1ns
update i’l’aga A20m 5011 1§ excel
Actor : Aauaszuy
Related Use Case : | -
9 v % 9 ] v
Precondition : ARUATEUIARIMIIANTTRYaUADNHINBEAY TN AN
A I A 3 ) ,
Tunsaiiinaziumsiiudeyavionnuiomy Insdns Ind doya
£ 2o ™ ¢ L ay g @
Nzt ueglug e excel Falldoya udonnuivayInsdwsiiay
v W L4 ] ' 4%,
ganyelnsoy TaegUunveglugduuuisimuall
AR v Ay < v g ALy Aa
Postcondition : ARuaszuuutoyavaonvano@y Insfwi JoyanTovie niegaslu
o, o d o A y 4 v g
database MMIULRDAMIINBIAVII 1NBLITTAITDYANYNADY LAz 1Ty
9 [ A A Y [ I~ a ~
Yoyaa1ganiing update tve 1¥insenuanuiluasaniga
Flow of Activity : | Actor System
1. Auassuunatjy imu
nneay TnsAwsidae lwd
excel
1.1 szuuudauuvesuiudeya
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2. fquaszuuihmsnatly
e ey
Browse I#18911M135810d

'11'\15 excel

Jd o
3. duaszuifon IWduazi

n13nA1j3 Open

4. fguas zuuihnisiden
A 1 Ay Ay P
n30%10 Neamstiudeyad

v v
a

21910 194 excel 1HIANT

A ]
nseu1ela

5. fauaszuunALN upload

fv,]}’JEJVlWﬁ’ excel

¥
2.1 szuuuaaanihiaduin Iddeua

o A ll 4
sEuuhIMsszynegueelng excel

A J
3.1 szuunaaInoguee 1 excel lu

¥84 textbox

4.1 STUULAAI]UAINYDA radio N

9 A
RITGEEATMIGIL

5.1 szuurhmsoudoyauen i lu

[}
=

A [ 9 A
munIoveNdguaszuuion
5.2 szvuivudoyainli1u database
v
ATUNINUAISIUTooUE U

wien iudoyalWg Excel aalu
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g 2
Database 1e/33¢U

Exception

Condition :

4 9 a A o A =) é
‘l“l/‘l’ﬁ excel %mmngﬂtmumwmwuﬂ A9 U 2 column ¥4 column L5
I~ < @ 4 A o [ [ d A '
vwiiluudenvnemy Insfny 1ag column Need Wudgyanyalinioev
{0 B 2 &
MuUNMnUA 7991 AAIS) , D(DTAC) 118 T(TRUE) ¥aluniia lnldaz

[ ALY a ety
AoV ASINUNIHUA

M 3199 3.7 AM0T U889 Use Case— U7 Ui lud19iue

Use Case Name :

U7 : i luminune

Trigger Event: | Aguaszuudeanisud ludoyadiiiuie
s k. 9 y FY v o o A Y @ s o
Brief Description : | fguaszuudeemsud ludeyasinne ioldassiumansmstine
A Y Y o &Y
A23aM30ABIN3 1HTIugAdNY 104
Actor : Aauaseuy
Related Use Case : | -

Precondition :

9 Y 9 °o_ o Yy o_ o ' A o
fﬂ@,uﬁ53‘]J‘1Jﬂi]\1ﬂ"l‘§llﬂh1‘llﬂ'lﬂ'lu'lﬂ TﬂElllﬂsll't)lquﬁﬂ'lﬂ']u']ﬂclﬁiJMHWﬂVH

Y
N13 update VDY A

Postcondition :

o ) o _ o A Yy o [~ a 9y W
5$'U'UWTﬂ’]illﬂ‘l“Uﬂ1ﬂ1u1mW@1WﬂmQﬁﬂi\ﬂﬂUﬂ?TﬂJlﬂH%iﬂllﬁglsU"lﬂU

mansnlanonly

Flow of Activity :

Actor System

1. Aquaszuunatfy ud lud
MUY
1.1 szvvsanauuudosuldnsen

o o Ay £
“Hll'lflla‘llﬂ'm1u1ﬂﬂﬂ@ﬂﬂ']5uﬂ“l"ll

2. dguaszuuiimsansen
o J 1
nuuay Insfmn uaznatly

search
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9 o Y o
3.1 fguaszuuiimsud lud
WneuaginIsnili submit

d‘ A [ Y
toduduMIUA 1

o_o

2.1 SEUUEAIToNaR B0

U

=

o o 9 v 14
ﬁNWmﬂmﬂWWTUTUﬂ@%HﬂWGQﬂTSHﬂqm

9 9 k4
p0nu1 wazdauansoud luld

3.1 $UUNINIG update MUY

¥ s 2 b7
3.2 W5V UMINS update 1851
NEAaaad U ludiiue

Ay
1381398

Exception

Condition :
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3.3 M309NUUUISVY (System Design)

3.3.1 UHUMNUTAITUABUM TN N UVBITZUL

PhoneNumber
Connection >  String
Processo
request special number data
R ‘ y
eceive
Datla Search
Operator , Prophecy Data Function
Client Server

510 3.3 UM TR UM HYBISE UL
2INNN9IAY AFZUIUMTITHNH Client To3v8 11)&a #la Server Taeh#ls Client 9311
4 [ @ o o 1 [ r'd [ 4 o v
MIouAoAUEN Server LaMIMsde YoyanmutenyInsann 11/8e Server iiforla Server 1651
9 I~ o o { a Aq v I v Y Al Py
doyavaonnuemy InsANNAIna 9 Server dxiduNlFlumstanisnudeyanaainnia
2 r o @ o q’/’
Client 7D String Processor %3 String Processor ‘mmi%ﬂﬂﬁ%’agawmmaﬂmwﬁ 91NUU Server
) o Y [ o’:Jl ~ [l J A ) < l:y
wihmaneay Tnsdnst lUdum vianansma Insaninerue Heglugudoya Wehamuaiedu
o ' v JdAMY o Yo u A M
Server 3x71N15aanaansn 1dnau 1%y Client 1iWoUAAI0DANIANTI User Interface U9
[ da o {
Application tazdiinsdowadoyanuismy Tns Ay Application 9z 1n1sudasdoyaiign

u

v g @ % : :‘1 o [ ]
afu13n181udav09 Application Hueanuaasdeyananiiive Tasiinisiinuluinazdiu

€

d’l
JU

y_ 9 o_ o

E4 1
Connection : f1dpanisdeyarmioaieuazdiueg msiauludiuteniumsivoudedy

o =

[} [ Y o v [ da Y
Server vzaetoya i Server nazduiludoyaninesmyInsdniniay vziinisddoyann

ne1uf2 Application 14#7 Client 194



26

: 0 g v v o A vq ¥
String Processor : M3¥191u TugutvziilunsivdoyanineauInsdnnonniodvead dnu
o @ 5 v  dq Y A o 4 d < v & o 1 °
5LUVILMINIAA String Hanaay Ingdw Wimde 4 @1 AluvdenviuemyInsdnd srdeldia

Y
NITAUN

so A

i o A g Y, v ag
Search Function : M33191u Tuauiidumspuilanruinldlumsaumuuomy Insann uag
A P & ) A STy )
wilsnguiumhmsaunnseenay Insdungudoya
S Y

Ed
o 1 <] o @
Receive Data : mstinuluduiivzidumssudoyanadnindunm Idein Server nio n1elu

] Q) ta
Client (99 tazii T uaawavunihoe Tnsdnnve 14

3.3.2 ﬂ1§66ﬂ!!ﬂﬂ§1ﬂ‘f‘jﬂyﬂ (Database Design)

3.3.3.1 ER Diagram

@ SubDetail 1
Prophecy PhoneNumber
m 1 1 m
1S naing CERLIRT
3 Prophecy f

1

m

Password lﬂi"lﬂﬂ?l

: ‘ PhoneNumber
Admin

3/ 3.4 4aAq ER Diagram vo3m319lugudoya
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3.3.3.2 gaziBuaveIm319lug udela (Table Description)

M3197 3.8 NeaziPualuLRazABENUBIAIIIY OperatorDTAC

Field Type Key Description
PhoneNumber VarBinary(4) Primary Key ey Insiwi
Name Varchar(1) ¥oi1nsouy

Yo v 3y v daa I yg ¥ a
Table : OperatorDTAC : Mg mSufudeyavesnungmy Ingdmind DTAC Wudliuims

g : v v Jdq ¥ o ¢
Field : PhoneNumber : 11J1 Primary Key ¥039pyanungay InsfAnin lsnuninams Insfnwi

E oy Al mer Gy Yq ¥ a
Field : Name SiudeinTevIgueId 1nuTMg

H [ c
M5199 3.9 NeazidenluuAasAeaNHUDIA151Y Operator TRUE

Field Type Key Description

PhoneNumber VarBinary(4) Primary Key waeay Insdmn

ﬁ' =) ]
TBLATDUNY

Name Varchar(1)

S

Y o v 3 Y @ [ Yqg ¥ Aa
Table : OperatorTRUE : l¥dmsuinudoyavasninomay Insfwinid TRUE dud1vusnns
= g : v v Jaq v o
Field : PhoneNumber  : (W Primary Key U8390yanungiay Insdwin i uninema Insdwi

& 1< A A ] Jyq ¥ a
Field : Name : Lﬂuﬂfﬂlﬂi'ﬂﬂl'lﬂﬂlﬂﬁl}jlﬁﬂiﬂ'lﬁ
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4 [ d
M5199 3.10 YazIDAl N aZABINIYDIMITIS OperatorAIS

Field Type Key Description
PhoneNumber VarBinary(4) Primary Key 4 nine@y Insimg
Name Varchar(1) Foinsouny

Y o v 3 9 o JAA 3 Yq Y a
Table : OperatorAIS  : ¥ mSuinudoyavesrunemy InsAwnni AIS WU liusms
. g 5 Y v ddqy g @i
Field : PhoneNumber ~ : 11U Primary Key Gumeuagawmmaﬂmﬁww%mwmmamimﬂwm

3 diP A AN Y9 ¥ a
Field : Name P L‘]JWHEJLﬂS’EJMEJ‘U@QEﬂW]Jiﬂﬁ

4 [ &
3197 3.11 NeazealuuAaznPaNHUPINTY Prophecy

Field Type Key Description
ProphecyID Varchar(1) Primary Key AUUAVATNIUY
Detail Varchar(750) s18azRuafR I g
SubDetail Varchar(750) J18azREAdpEA1Y
9 o v @ 9 o_ o
Table : Prophecy : Gl‘lfﬁ?ﬁiﬂ!ﬂﬂ‘ll@gﬁ‘ﬂﬂﬂﬂ?ﬂ?ﬂ'lﬂ
I~ o I o o
Field : ProphecyID : 41U Primary Key ¥03dayamsinnumnuniieavsiuigy
3 I~ ] a g = ) a o o
Field : Detail STudrunnusIBazReaf 105 UeR 18 Tags
< [l { g o a 0ELo v (] a
Field : SubDetail SiudunnuTeazoeaf 19T LR MINIgEDYY 111 MY, NTIRY

AN HASgUNIN
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M99 3.12 SwaziRual L azAaNYBINTIY Admin
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Field Type Key Description
username Varchar(10) Primary Key Username “U’ENEEI@' Hassyy
password Varchar(10) Password aumé’”uai YUY

5 ) v g [ °
Table : Admin 1¥d1MF1IAY Username 1ag Password v0dgquaszuy 14 umstuiunsiny

ﬂ”N‘] mmmi%’ﬂmigmﬁl’fagmmiwuuu Server

Field : username

Field : password

= : : 8
11 Primary Key ¥Y93§11374 admin 141y

ch- iy { =
Siludunldiny doya password

51’1}6 U8 username

U
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UNM 4

Nan1SAUHUIIU

4.1 1UAZRYAVBITZUL

[ o 2 a S A ! Y g ¥ o JA A
szuv lagniwainau Tasligaiseasmiie aaelvg g InsAwiiedeaunsoniy
A o o ey a 1y Y o & o
s eusveInIneay InsFnidatenendesnsaane 1a saunsdeeuisansiuneg e
da Y 9 & A o 3 = ! 9) [ 4
wazweinie 1aonale Faseuviianyaiutuy client server 1agN14 client 92 19 INTANN
a ua J 2 A o ! A Y
smart phone ‘umzuuﬂgmmm android N1%117158911/51n53 Mobile Operator Check welH
o A 9 Y i o W Y
dldsunsuamnsaizdesuadoyanienan server 1183021450033 1A a3 server g
Usznon 10 web server 1Az database server 198 web server 3291 NIan1snudeyaly
9 3 Y Ao o [ 9 Y
database server LQ1¢ database server Gl"]SLﬂ‘]J“U’e]ﬂqJ,aVIﬂWﬂﬂJumﬁc]EUENR‘]J‘U Usznoude Uoya
[ Jd 1 T o o 9, Yo
block inway Tnsdwit Toyanievwvesusazrutoiay InsAnt deyadihiue nazdeya

9
username , password UDIHALATLUY
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4.2 HAMSAUUUIIU

Y J v A 3 a
szuvezilsznoullaae 2 aundnde client 1A% server 1ABIZOTUIOHANS

e

o Aa 1 g o Y v A
mmmmumzﬂu 2 U9 AU
4.2.1 client

Y v o { o a ua
M3rla client § 1992 19 TnsAwviilofio smart phone MvhamuuszuUUFUiANS

android %9¥17158411/514054 Mobile Operator Check 13

B

1| € 8:11 Pm

MobileOperatorCheck
Input PhoneNumber :
10804412747

! S 2
nngdh 41 wzflunidieesuduveslUsunsy gléarmisansennuisay
Y

2

o d { T a U 4 o
Tnsemndotondlddesmansnuaieied1du5ms udanatly submit 1ieshasAu 1o

' 4 9 g '
natlu cancel ioavemyiinsen 11 uasdldausanatlu special number fivgwieay

WAy I UHLIAA199
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. 4 o o U I 3
131l 4.2 diedldihmansenvunoay Insanwiedondanaily submit aziifuns
< o § s = & ol
dalv Tlsunsuiam wie ldwndeyamiesied 1905015 vesnuaay Insawnng 19 la
v X2 v & 999 o o o Y
ason i) uazuaaaniiwetiauu vianhidlFaunsagmiuisarsnnyvinoay Tnsdn 14
Taoidonunuy prophecy 1A love HlFawisadounay lvrhiSuduvesTsunsy e

o L T 1 5
nyenvmeay Insawi 1 Tnenat)y main page
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Operator

0804412747

Prophecy :

=

08

13N 4.3 diodldenuanwy prophecy Tsunsuguaasniinomiiue laosiu
2 P o Vo o o a v v &
Juan Taefimindiunelis s iamuveuniine §léauisaldin seroll bar N1
Y A 4 v y Yl v y & o 9 A
M nieineurniveasngdeyadiua1cla anmiigldamuisadonun iy operator
MO v 9 & Ny A oA & o o a a a
ienan g ueauns ov1e Wi e @enua ULy love Lo uehiineazidealandoy

4 X A ! : A o o 9y A g9
WINGIVU W50 NALJN main page onan ldamihisuduvesTusunsuy
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- i gl
-

Operator Prophecy

0804412747

Prophecy :

A
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main page Wionay lUgamiisuduveslysunsuy
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Gl @ 8:11pem

MobileO peratorCheck

Input PhoneNumber :
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MAUIN 1. Tumeumsaaadllsunsulumsityrviey

f. 1 MIAAAT Java SE Development Kit

Java SE Development Kit i yamdaluniswannlsunsudioniziain

[

AINTU

o a J A a J J o @ o A
Wﬁl‘lu'ﬂﬂiLlﬂﬁllﬂ@NW?L@@ﬁUuLﬂﬁ@Qﬂ@NW']L@@ilﬂﬁﬂtﬂ@ﬂ‘ﬂjqﬂ GgﬂW@luWu!ﬂulﬂﬁiﬂ’]uvl

o a o 9 a < Jd
gnimualagussn du Ty lasdamand

1) @191 11189 Java SE Development Kit 910

http://www.oracle.com/technetwork/java/javase/downloads/index.html

¢ Favorites

E Java SE Downloads )

iz @ Suggested Sites v g Weh Slice Gallerp. v

g‘l]ﬁ f. 1 URL U84 Java SE Development Kit

4 U J" =g a 1
2) iiiold URL Bevdoouda vzisnguinaniiilnan Java SE 4WiN Aanty [Download JOK

JL A @ 1 @ o
Java SE 1183 ¥ufid0ans (mndiedeaagi) mena191i 1vana Java SE 6 Update 24)

L & LR
= ’h‘ = JavaFx |
lava — i
o T
Java Pistform &DK) . JDK - JavaFX Bunul;
JOK JRE

Here are the Java SE downloadﬁ Ill detail.

DEVELOPER.COM 2008
; | PRODUCT OF THE YEAR /|

. & NetBeans

JDK ~ NetBeans Bundile

!
1
i
;?

Download *

__Download £

JDK + Java EE Bundi®

Uava Platform, Standard Edition

Java SE6 Update 24

[This release includes security enhanc
fixes. Learn more »

and bug

What Java Do | Need? You must have a copy of the JRE
(Java Runtime Environment) on your system to run Java
\applications and applets. To develop Java applications

‘and applets, youneedthe JDK (Java Development Kit),

which includes the JRE.

\Download JDK [Download JRE]
DK 6 Docs URE 6 Docs
Installation - Installation

| Instructions | Instructions

* Readlle * Readie

* ReleaseNotes
* QOracle License

* Third Party
| Licenses

» Supported
| Svstem

| Configurations

* ReleaseNotes

* Oracle License |

7 Third Party
| Licenses

* Supported
| Svstem
| Configurations

Ca
=
=b.

N.2 AIAANI Java SE
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a wua @

Y A Ay Y Y o v A
3) NUULADN Platform ﬂlﬂﬂigﬂﬂﬂgﬂﬁ‘ﬂﬁd mum@amﬂﬂumawmumaﬂmmm‘mn&J

i [l

[

gnlaemsnaniyesf@naonnidenau « 1 agree to the Java SE Development Kit 6u24

3 4 < 9 NI SR
License Agreement > tilodonidiaEondosudinaniy

Java SE Development Kit 6u24

Provide Information, then Continue to Download

Select Platform and Language for your download:
Platform: | Select... E]

Language: Multi-language

[ agree to the Java SE Development Kit 6u24 License Agreement .

Continue »

gﬂﬁ 7.3 (o Platform U3 Java SE Development Kit

4) iionaniarszlsngueh Download Java SE Development Kit HLe99318a2180A109
14 Java SE Development Kit (01001078 114 jdk-6u24-windows-i586.cxe ¥11A 76.58 MB)

AANN jdk-6u24-windows-i586.exe 110191 111an Java SE Development Kit

Download Java SE Development Kit 6u24 for Windows, Muli
language

Download information and Files

[\ Getthe latest Java Runtime Environment io use Sun Download Manager

Internet Explorer Users: Check the top of this page for a "Java(TM) Web Start ActiveX Control”
message in the information bar. If it appears, click itto finish detecting your Java version.

We were unable to detect a recent version of Java Runtime Environment (JRE) on your
system. With the latest JRE, you can automatically download, install, and run Sun Download
Manager (SDM) directly from this page. We highly recommmend SDM to easily manage your
downloads (pause, resume, restar, verify, and more). Visit java.com for the latest JRE.

Instructions: Click the file name to start the download.

Available Files

Java SE Development Kit Gu24 76.58 MB
¥ jdk-6u24-windows-i586.exe

= ] ¢
510 n.4 wiha1Ilvan Java SE Development Kit
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4 =y 4 . - B Al & lg = U
5) 11eAANRT jdk-6u24-windows-i586.exe 1132 921/51NN111A19 File Download 11 AANTY
y ¢ J o 1 @ 4 ' =
Run 1109 191§ jdk-6u24-windows-i586.exe 13191 Tag liifimstiuiinauasosnen aantuy
A o = A A Yy A Yy a 2
Save 1#017U#1n Java SE Development Kit aun304414 W3t doanissniann1sn1dil lvaa

ﬂaﬂﬂll Cancel

- —
File Download - Security Warning @

Do you want to run or save this file?

lﬁ 1l Name: jdk-6u24-windows-i586.exe
L. Type: Application, 76.5MB
From: cds-esd.sun.com

Run ‘ [ Save ] r Cancel ]

| i— N NN S S b . N

1 3 1 While files from the Intemet can be useful, this file type can
45} potentially hamm your computer. if you do not trust the source, do not
=" un orsave this software. What s the risk? i

P

Uil 0.5 TuAn jdk-6u24-windows-i586.exe

6) ol lnaaidsudeouda 118198 jdk-6u24-windows-i586.exe

jdk-6u2d-window
5-i586

510 n.6 dree1alula jdk-6u24-windows-i586.exe
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o £ a Jd . 3 2 An ¥ o [ ' Y 1
7) duiananIng jdk-6u24-windows-i586.exe 1 lan1211 Inaau sodnAzIzLlsIngriime

Java SE Development Kit 6 Update 24 Setup UHU ﬂaﬂ‘]JjJ e ldsvunou

' v
da 11 WSondnily 1WPPONIINMTAAAT

%) Java(TM) SE Development Kit 6 Update 24 - Setup

Kit 6 Update 24.

Welcome to the Installation Wizard for Java SE Development Kit 6 Update 24

This wizard will guide you through the installation process for the Java SE Development

ORACLE’

b Mext> ] [ Cancel ]

gﬂﬁ f. 7 %0 Java SE Development Kit Setup

H £
8) 1390 Feature N9109015 Install Y09 Java SE Development Kit 6 Update 24 Taeludguil

[ 7

H 3 .
AININABARNE Feature  NA09n15 1AYUBGRUAWAILOZITON Directory V04 Java SE

. R y = Al
Development Kit 6 Update 24 Tagaant]u Wiadenaiatoudoonda aanty

|‘ MNext > I

t;"Eljla\va(T M) SE Development Kit 6 Update 24 - Custom Setup.
N Y

Custom Setup

Select the program features you want installed.

Select optional features to install from the list below. You can change your choice of features after
(| installation by using the Add/Remove Programs utility in the Control Panel

Feature Description

Java(TM) SE Development Kit 6
Update 24, induding private JRE
& Update 24. This will require
300MB on your hard drive.
- (&) = | Public JRE
Install to:
C:\Program Files (x86)Java\jdk1.6.0_24\

ORACLE’

[ <Back [ Next>

| [ C;ncd ]

510 0.8 ¥¥UAAI Feature Uaz Directory



9) 59M15AAAY Java SE Development Kit

ﬁl Java(TM) SE Development Kit 6 Update 24 - Progress

Installing

The program features you selected are being installed.

51/ 0. 9 WINWAAIENUNITAAAT Java SE Development Kit

A ; 0w & ' Lo VY | ™ y
10) @0 Directory f1¥3U Java Runtime I@ﬂﬂqﬁﬂﬂﬂu ‘ gh‘a,nge..k. DA BNLIYUIDY

F 9
udyadnily [ Next > JuiadesnisenidnnisAnng Java Runtime adntul L el ]

Destination Folder

Click Change...” to install Java to a different folder:

Install to:

C:\Program Files (x86)\Java\jre6\

|

gﬂﬁ .10 % Setup Java Runtime
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11) 59M138AAY Java Runtime

@ Java Setup - Progress

Installing Java

This may take a few minutes

Now you can have a full-featured office suite that’s
compatible with Microsoft Office for free!

« Powerful, inteqratad set of word processing, spreadsheet, presentation, drawing
and database applications

+ Reads, edits and saves Microsoft Office files
= Supports over 70 lanquages and Solaris, Windaws, Linux and Mac operating systems

Uses industry-standard, open file format (OpenDocument) as its default file format
Builtin, one<lick PRI export

B B B &8\ e OpenOfficeorg

511 0. 11 ¥ENUEAIE9IUEMIAAAT Java Runtime

A 4 Z’, ! a Y 9 a 1 : . 4 A 3 Qy a 3’,
12) 1i0AAA Java Runtime 581308107 AANIJY DL DA UNITANA

Java SE Development Kit

Java(THM) SE Development Kit & Update 24 sumessfuzlly Installed

Product Registration is FREE and includes many benefits:
* Notification of new versions, patches, and updates

* Special offers on Sun products, services and training

* Access to early releases and documentation

When you dlick Finish, product and system data will be collected and the JDK product
registration form will be presented. If you do not register, none of this information wil
be saved.

For more information on what data Registration collects and how it is managed and
used, see the Product Registration Information Page.

{ Product Registration Information ]

51/ 0. 12 WiuaaIM3AAGI Java SE Development Kit ta3ai3au50aua,
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.2 MIAANI AppServ

AppServ A0 yalilsuninludnyaizvos WAMP (§AU83 Software 13281un1509

9 < ad d o a ua "
Apache, MySQL uag PHP) lumisadiedu@swineidusagluussuulgians Windows
() 4 a I @ I ad Jd 1
farhlas ;e daand dumssuTdsunsy 4 dlumsahadugsvnes Tdua

Apache HTTP Server, PHP, MySQL (18 phpMyAdmin

1) i lvan AppServ N http://www.appservnetwork.com

@ Appaer\rNehiork Wmdow.» lnternei Explor

%@u e e

y Favorites | 93 ,é Suggested Sites,y @ Web Slice Gallery ¥

@AppServNetwork | o~
i bkl - )

5191 0. 13 URL v@4 AppServ

2) AanT http://prdownloads.sourceforge.net/appserv/appserv-win32-2.5.10.exe?download 1o

¥MsAi 11aa Appserv (1AW 188NA13% 11an AppServ 2.5.10)

AppServ 2.5.10

Apache 2.2.8
PHP 5.2.6

MySQL 5.0.51b AppServ
phpMyAdmin-2.10.3

Download
Sourceforge.net : http://prdownloads.sourceforge.net/appserv/appserv-win32-2.5.10.exe?download

MD5SUM : 279c0c39866fbechBa3004269fd5d0f4

517 0. 14 w¥huea Link aiilnaa AppServ

4 a A '3 1 d tg
3) eAfAnd Link a1% lnasudrnzsinguiaesemsani vaauuin uazazising
A [ a A 3 =) ”
Tab MoUAINYanANBYDY Web Browser  AAN Tab “V]‘]J'ﬂﬂg"uuiﬂ 1890 Download File...

9y
(RN Internet Explorer (NTUU)



¢ Favorites | 5k @ Suggested Sites v @ Web Slice Gallery v

Download AppServ from SourceForge.net

&~ v 4 @ v Pagev Safety~ Toolss

Find Open Source Software

SOuUrceForge

T —

| - Your AppServ download will start shortly...

or try anather mirror.

@ To help protect your 5é:umy, Internet Ekplnrer‘b[uckevd this site fmr;_i downlaédlng files to your mmp}

|
|

Download File...
What's the Rizk? Register Lo

Information Bar Help

Problems with the download? Check your browsers security bar at the top of the page. or try a direct link,

Mirror provided by: @coNetm

51 0. 15 wihanilwan AppServ
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v a 1 = 3 a 1
4) M§99NAAN “Download File...” 4d2 92151n911A19 File Download Y1 AaN1w

A 4 g Y o (= o &R A ' al
Run tiiedelild appserv-win32-2.5.10.exe Ty Tae lifimstiuiinauniesnou ﬂﬁﬂﬂll

Save 101 UTIN appserv-win32-2.5.10.exe AUATDIRIALT W3 1ABINITENANATAT/N Cancel

File Download - Security Warmn

Do you want to run or save this file?
Neme: appserv-win32-2,5.10.exe

[‘; Type: Application, 16.4MB

’ From: cdnetworks-kr-1.dl.sourceforge.net

N

{ Bun Save ] E Cancel ]

e % While files from the Irtemet can be useful, this file type can
\?} potertially ham your computer. If you do not trust the source, do not

!I 5 run or save this software. What's the risk?

e

| ol e R VTl T

gﬂﬁ 1.16 10 appserv-win32-2.5.10.exe

4 ! s
5) WAl Ianiseueudd 9 ld 1Wd appserv-win32-2.5.10.exc

appserv-win32-2,
510

gﬂ‘ﬁ . 17 feehalvla appserv-win32-2.5.10.exe
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9 2 a J 1 g 4 @
6) suiiinnan 1 appserv-win32-2.5.10.exe  321/51 1A Setup Iuun odoens Tl

& 3 a a %l/ a 1
Juneuda 11 aaniu ¥3edeIMIENaNMIAaal Aanly

Welcome to the AppServ 2.5.10
Setup Wizard

This wizard will guide you through the installation of AppServ
2.5.10,

Itis recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

gﬂﬁ 0. 18 HiN AppServ 2.5.10 Setup

1 3 9 1 a &”J [ 1 a g’/
7) ﬁ?J111L‘l]uﬂqulﬁﬂﬁ%}ﬂﬂﬂﬁﬂﬂGUﬂ'ﬁﬂﬂﬁfl AppServ 2.5.10 EB{'IEJE]NTU‘IBJI@@ﬂﬁQﬂ@uﬂ"IﬁﬁﬂﬂQ

Y T
Aaniu [(agee | y3odosmsnsuliunouiiiumn anntfy

License Agreement

Please review the license terms before installing AppServ 2.5. 10,

Press Page Down to see the rest of the agreement.

GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install AppServ 2.5.10.

Mullsoft Install System vz, 18

[ < Back ” 1 Agree I[ Cancel

a v v ' a o
31]7] . 19 KUUTAUDANAINBUNIAAANY AppServ 2.5.10
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v Y v
8) 180N Directory N9¥11N15AAAY AppServ 2.5.10  1asn1snaniju i1
iwon laGouseoudinanily

Choose Install Location
Choose the folder in which to install AppServ 2.5.10.

Setup will install AppServ 2.5. 10 in the following folder. To install in a different folder, click
Browse and select another folder. Click Mext to continue.

Destination Folder

ADD ! [ Browse...

Space required; 56,4MB
Space available: 19.8GB

A Y A 2 a o
gﬂ‘ﬂ . 20 ¥ aen Directory ANAY AppServ 2.5.10

9 £
9) 149N Package 1UM3IAART AppServ 2.5.10  Package NN41NA 4 Package 1AlA Apache

HTTP Server, MySQL Database, PHP Hypertext Preprocessor, phpMyAdmin Tagn1snan

1 { { 4 3 4 <] a H
Fosmmavulnangaieanuiegniunn Werdoniaiaids aantu

Select the components you want to install, clear the components
you do not want to install.

[¥]MySQL Database
(V] PHP Hypertext Preprocessor
[] phpMyAdmin

<Back [ Next> ] [ cancel |

310 0. 21 WA Package M3AAAT AppServ 2.5.10
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10) n58AT3AVDY Apache HTTP Server 1811 %0 Server (localhost), Email ¥044giasz i,

] v il
HTTP Port  iijensendeyananuaiioudoonda adntu_ Next> | uilel1lds
Y

Tunousa 'l

Please enter your server's information.

Server Name (e.g. waw.appservnetwork.com)

Iocalhosf

Administrator's Email Address (e.g. webmaster @gmail. com)

youremail @hotmail.com

Apache HTTP Port (Default : 80)
80

d’ Y Y
31l0 0. 22 winsenveya Apache HTTP Server

11) nsendeyaveemILFuiss MySQL Server 1ALA Root password (W AFQLATZ L) NION

Y v

?:1/ 3 1 dy 91 ::' o Y Y. A
NINUA 2 ASY, MySQL Server Setting (dauilenunsnldandmuainliugald) ensen

) g

Yoyanavuaisoudoouds adntu [ Istal__fifNeiTun1s nstall

MySQL Server Configuration
M p_ D L Corifigure the MySQL Server instance.
Yol
Please enter Root password for MySQL Server.
Enter root password
“eee

Re-enter root password

MySQL Server Setting
Character Sets and Collations
[UTF-8 Unicode -]

[ 0ld Password Support (PHP MySQL API function.)
[ Enable IrnoDB

[ <Back [ mstal
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9
12) 50MIAAAI AppServ 2.5.10

Installing
Please wait while AppServ 2.5. 10 is being installed.

Extract: php _qudIl

Show details

319 0. 24 WEOWAAIETOIUEMIAAAI AppSery 2.5.10

13) Firewall HAAITANNIAD NI “MTT1TUVDI Apache HTTP Server 0 Firewall NANT

o 1 k- go < o - 2 '
NNIUBDY 1 Glmmmauu%1Lﬂuﬁaaalgiy1$¥1ﬂ1§m1mumad Apache HTTP Server hlm%uum]zuln

an5014 Appserv 18 Tngadntlu [ Alowaceess

Windows Firewall has blocked some features of Apache HTTP Server on all public and private

networks.
\ Mame:
Publisher: Apache Software Foundation
Path: C:\appserv\apache2. 2\bin‘httpd.exe

allow Apache HTTP Server to communicate on these networks:
[ Private networks, such as my home or work network

[¥]Public networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing a program through a firewall?

Allow access ] [ Cancel

$ A o U o
51 0. 25 HHARLUAAINITINAMIINNUIN Firewall



14) aanijy {IDIUMTAAAT AppServ 2.5.10

Completing the AppServ 2.5.10
Setup Wizard

AppServ 2.5.10 has been installed on your computer.

Click Finish to close this wizard.

[] start MysQL

ke
=
=1
a.
=
(S

)

www. appservnetwork. con.|

51/ 0. 26 WihuaaIMsAane AppServ 2.5.10 ta3aiFau 581

80
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1.3 MIAAAI Eclipse IDE

: A Ay v s A ' ;
Eclipse IDE 719 open source Vlgﬁkuuiumﬁ?f'ﬁNLLWﬁGIW’EJ‘S?JVIEJﬂWEun, runtimes Qg

o @ @ a 4 ¢ P U
application framework @5 UNIAI19ALAITIANSTINNTFIAVBIEOIAIITNINNA T
1 ) =] o 4 o [
TrnajgnWanndieni Java  uadansaldimndlienimduldiiiesInan Plug in d1v5y

v v

AMHIUULIAAA.

1) Al Inan Eclipse IDE 910 http://www.eclipse.org/downloads/

W B i 5
@ Suggested Sites >

i Favorites | i3

2| Web'Slice Gallery/v

| n EdipseDown!‘c;ads‘ 5 ‘ i‘-} %

}

51 0. 27 URL wesnthaarilwan Eclipse IDE

4 A =) a ua
2) a1 vaa Eclipse IDE for Java Developers  las@enaiuiszianszuulgians

Windows 1a8ii1 il Windows 32 bit ttag Windows 64 bit

11 Eclipse IDE for Java Developers, 99 118 Windows 32 Bit

Downloaded 76,149 Times Details Windows 64 Bit

s1lii 0. 28 WihuEAs Eclipse IDE dmTumanilyian
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y a wa = J 5 3 a {
3) iedenszuulfiamaeudesuda azalsinguieiTvan Eclipse IDE yuun Aani

ioa11i 14an Eclipse IDE (11nA1miAonan11l 1naa eclipse-java-helios-SR2-win32.zip) i

Eclipse downloads - mirror selection

All downloads are provided under the terms and conditions of the Eclipse Foundation
Software User Agreement unless otherwise specified.

Download eclipse-java-helios-SR2-win32.zip from:
[China] Actuate Shanghai (http)
Q Checksums: [MD5] [SHA1] @ BitTorrent
...or pick a mirror site below.

Get It Faster Here

. nWire Software
Blazing fast Eclipse downloads over Limelight CDN. No reg reguired.
[ ] Optional code exploration tools.
NWIRE

A SpringSource
X Rapid downloads of Eclipse packages. Free downloads of
“= SpringSource Tool Suite for Spring, Aspect), Groovy and Grails,

A v : ¢ ,
11 n.29 wihwaas Link a1211%an Eclipse IDE

) v 2 Sl §y ¢ J
4) 11U agalsngniiia1e File Download 1 ﬂaﬂ‘lj iedela
5 : " : . Y o 1A o K A ' a
eclipse-java-helios-SR2-win32.zip Iihaiulae lilinisunnasasesnau ﬂaﬂ‘lqlﬁJ
[ save  Jiletfufin cclipse-java-helios-SR2-win32.zip a9iA309 W3 edideamsuniannis
o i of
At lviaa Aanijy

File Download

Do you want to open or save this file?

@ Name: eclipse-java-helios-SR2-win32.zip
Type: WinRARZIP archive, 99.1MB
From: download.actuatechina.com

Open j { Save } [ ~ Cancel ]

Mways ask before opening this type of file

‘@' While files from the Intemet can be useful, some files can potertially
L & 4
&

harm your computer. If you do not trust the source, do not open or
save this file. What s the risk?

s —
b e Z z e T

gﬂﬁ f.30 uhn eclipse-java-helios-SR2-win32.zip
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4 o 3 J ‘ . ‘ o
5) Wioa Inaaaiasoudoonds 9218 1WS cclipse-java-helios-SR2-win32.zip 141013
s Jo 4 ~ i a A J
uan s @suanlndsuiuedoali1sunsu WinRAR 38 Winzip) lasmsaanuni lild

eclipse-java-helios-SR2-win32.zip 180N “Extract Here”

| NSRRI A
Open
% B Extract files...
! B bBdract Here
| B Extract to eclipse-java-helios-SR2-win32\
| ;
eclipse-java- Open with »
5-5R2-wir
SR Share with »

© Show Versions...
Restore previous versions

Send to > |

Cut
Copy
Create shortcut

Delete

Rename

i Properties

g‘ﬂﬁ n.31 uanlvla eclipse-java-helios-SR2-win32.zip

6) derhmsuan g eclipse-java-helios-SR2-win32.zip 1187 %3 Folder ¥® “eclipse” ‘ﬂ‘ﬂﬂg

E] & g < ;
YuN1 Y Folder 11U Eclipse IDE

eclipse

510 0. 32 Folder Mfiv Eclipse IDE
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N ] y i o ¢ w &
7) 178 Eclipse IDE 411 Taoidh Folder ¥0 eclipse 71 Idvinisuanlidesnun  udaduidia

ﬂaﬂlﬂﬂ‘h\lﬁ%@ “eclipse.exe”

. configuration 2/18/2011 4:31 AM
.. dropins 2/18/2011 4:31 AM
.. features 2/18/2011 4:31 AM
g p2 2/18/2011 4:29 AM
o plugins 2/18/2011 4:31 AM
. readme 2/18/2011 4:31 AM

eclipseproduct

ey

=% artifacts

7/29/2010 10:37 AM
2/18/2011 4:31 AM

|2 eclipse 12/22/2010 2:08 PM
¥ | eclipse 2718,/2011 4:31 AM
B eclipsec 12/2242010 2:08 P
& epl-vi0 2/25/2005'6:53,PM
& notice /2772010 3:23PM

g‘l]ﬁ .33 Inla eclipse.exe

A ~ 9 a T %‘/ 2 A
8) 190 workspace NADINII IABAIIAANLY NUUNBIADN workspace

130f84n151a Eclipse IDE AAN1JH [ Cancel ]

=3 Y 9 a T
Liﬂﬂiﬂﬂklaiﬂﬁﬂﬂ‘ﬂ

0
= Workspace Launi

Select a workspace

Eclipse stores your projects in & folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | [GRUEIENERENEINTI LIS

]

| Use this as the default and do not ask again

LS

a A
qil‘IJ‘Yl . 34 199N workspace
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4 2 a
9) L‘ﬁ@ﬂﬂﬂgﬂﬁlﬂ Eclipse IDE Vuaudn 1‘31Z1ﬂLﬁ’i:)f1L3J°LJi Help -> Install New Software...

(Help |

(%) Welcome
Help Contents

@7  Search
Dynamic Help
Key Assist... Ctrl+Shift+L
Tips and Tricks...

4 Report Bug or Enhancement...
Cheat Sheets...
Check for Updates
Install New Software...
Eclipse Marketplace...
About Eclipse

g‘ﬂﬁ fl. 35 sy Help -> Install New Software...

M3 Tnaa Android Developers Tool GRLERT Eclipse IDE

F‘Q Install

Available Software

Select z site or enter the location of a site.

4 a 1 lg a T
10) 1oadnua29zU51ngUIIAI Install V0NN AAATj|  Add..

Wi URL 1

Work with:”
"t'ypﬁ“{-iker t!"lt“ 7” y &
Name

| @ There s no site selected.

SdectAll | [ DeselectAll |

Details

[7] Show only the latest versions of available software
[V Group items by category

[¥] Contact all update sites during install to find required software

84 K | -
s
Add...
Find more software by working with the " ble Software Sites” p es.
Version
[} Hide items that are already installed
What is already installed?
Y
< Back nish Cancel

a v
517 1. 36 % Update Eclipse IDE
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1 1 4 J
11) 11119 Add Repository  1teyalinsen 2 409 fie ¥8 uag Location (URL Tun1sad

Traa a1nnmeels URL  Wu https:/dl-ssl.google.com/android/eclipse) Lﬁ@ﬂi@ﬂ‘ﬂlﬁlgﬁ

Fovdeoudandn 1w viatdesmsonidnaanily | canel |

= Add Repository St III 3 ]

Name: android Local...
Location: https://dl—sﬁl.gobgle.com/android/ekIipse/k e

/:\ | OK I [ Cancel l

A\l

. 37 ¥iH1M19 Add Repository

=h.

31

Y

3 g’l v 1 3 a { 1 4 t:'
12) ndaniusednai 9213109 Developer Tools Jua Aanfives@masudunthld

A A A ) A A A 9 I\ G
Lﬂ‘iawmﬂgﬂﬂ‘imgmam@ﬂ Developer Tools NABDINIT Lllam@ﬂlif]llﬁ@ﬂua')ﬂﬁﬂljll

[ hextz _ Jvdedrdosnnsemdnnishnundnty | | Cancel,

Available Software
Check the items that you wish toinstall.
Work with: android - https//dl-sslgoogle.com/android/eclipse/ ; T\ I Tl
Find more software by working with the "Available Software Sites” preferences.

typefilter text

| Name Version

1ha @60 Developer Tools
(V] 4g* Android DDMS 10.0.0.v201102162101-104271
) :Q Android Development Tools 10.0.0.v201102162101-104271
] 49 Android Hiersrchy Viewer 10.0.0.v201102162101-104271
(V144 Android Traceview 10.0.0.v201102162101-104271

Select All | [ DeselectAll | 4 items selected
Details
V| Show only the latest versions of available software | Hide items that are already installed
|| Group items by category What is already installed?

[V] Contact all update sites during install to find required software

gﬂﬁ f.38 1800 Developer Tools #1151 Android
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[ 1 Y =Y A Y A 9/§ a 1
13)  sodnaj adsingniiaisuaasiivazideants nstall A lAden Hauu adnty

' 9 : Y
e ldsauaeunall wiendn iend Tduuaeunennii

9 v
14) 1/iﬁ\‘ﬁ]']ﬂuu‘tlzﬂﬂﬂ{]ﬁﬁ}ulﬁﬂ\‘]"ﬁ}@ﬁﬂﬁﬁﬂﬂi‘lﬂﬁ Install i?II'IEJmJ'iUﬂﬁﬂVI’NﬂmJ

Y v
YUIUDAIY

O tnstall

Install Details r_'f
Review the items to beinstalled. =]

Name
3 Android DDMS
4§ Android Development Tools
43 Android Hierarchy Viewer
4§ Andreid Traceview

Version Id
1000.v2011021621... com.android.ide.eclipse.ddms.festure.gro,
1000.52011021621... com.android.ide.eclipse.sdt.festure.group
1000.52011021621... ¢ droid.ide.eclipsehi y

1000.v2011021621... droid.ide.ecli featu

Size: Unknown

Details
@ a1 g S, s

= a
31.]71 . 39 3gazeenn13 Install

“T accept the terms of the license agreement” uazﬂﬁﬂﬂu

1WBI5Y Install Android Developer Tool

8 lstall

Review Licenses r—
Licenses must be reviewed and accepted before the software can be instalied. \)f“
Licenses: License fext:
N Pl icerie _
Note: jcommon-1.0.12jaris under the BSD license rather than the AL
Note: kxmI2-230.4ar is under the BSD ficense rather than the EPL. Vn'

© Lzccept the temms of the icense sgreements

i ’ 1 do not accept the terms of the license agreements
®» BT Cemd |
‘

€an
=
=Sp.
-
'
(=

HINUFTAIVOANAINOUNT Install
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f. 4 MIAARNI Android SDK

Android SDK (Android Software Development Kit) ﬁ’e‘) ‘gﬂiﬂﬁuﬂiwﬁ%%‘i Google
Wannesnuiernieliiiniamn Application 3 adaulanallerninaa lldiaulae
hifiarld91e 1u6§ﬂ1ﬂstxﬂiu5ﬂzﬁTﬂmﬂﬁmmz"lamﬁsshm fsuiudemswaun
Application 111 Android 151 Emulator #9vh1#anunsnadie Application taziimmaaesiy

v Y o o Yy A A A A a gy
U1 Emulator Llﬂ T@a@,wmmmmsamamﬁm’;zuma@wmuaumaafuiﬂﬂ

1) A1 1%1a@ Android SDK 970 http://www.eclipse.org/downloads/

{v Favorites ‘ | @ Suggested Sites v/ i Web Shice Gallery ~

’éAndmdSDMAndrordDevelopers % | -

¥

31/l 0. 41 URL %03 Android SDK

2) 1ionA111i 111 Android SDK d%51321U1§1TANS Windows A® android-sdk_r10-

windows.zip

Download the Android SDK
Welcome Developers! If you are new to the Android SDK, please read the steps below, for an overview of how to set up
the SDK.

If you're already using the Android SDK, you should update to the latest tools or platform using the Android SDK and
AVD lManager, rather than downloading a new SDK starter package: See Adding SDK Components.

Windows android-sdk_r10-windows zip 32832250 1942b8f528d9c36d9b887c58c6f1b932
bytes i
installer_r10-windows .exe 32878481 8ffa2dd734829d0bbd3eab01b50b36cT
(Recommended) bytes
Mac OS X android-sdk_r10-mac_x86.zip 28847132 23aa5578a6553b69cc36659c9505be3f
(intel) bytes
Linux (i386) android-sdk_r10-linux_x86 tgz 26981997 c022dda3a56c8a6769826a39b0b1a4e0
bytes

517 0. 42 Link @12111%aA Android SDK



4 a 1 lg a T ¥ Q'}
3) ifendnudr szUlnguiiisa File Download Y13 Aanijy | Bun ATRGE

89

4 o 1 @ 4 U a 1
194 android-sdk_r10-windows.zip 1¥hau Tagliimsiuiinauasosnon aanify [ se

A o o= = . : A Y o A gy a 2
INBUUND andrOId-sdk_rlO-Wlndows.21p mmimzﬂwmm ﬁﬁFJE]W]'E’Nﬂ']ﬁElﬂ!,ﬁﬂﬂ'l‘iﬂ'l:]uiﬁﬁ@

i adndu

File Download . - li&

Do you want to open or save this file?

@ Name: android-sdk_ri0-windows.zip
R Type: WinRAR ZIP archive, 31.3MB
From: dl.google.com

Open ] [ Save ] [—Cancel ]

[¥] Always ask before opering this type of file

=

@ ~-| While files from the Intermet can be useful, some files can potertially
g harm your computer. i you do net trust the source. do not open or .F
¥ savethigfile. \What's the risk?

§1Jﬁ f. 43 Junn android-sdk_r10-windows.zip

4 o 3 s o
4) dloani naaaseisaudeouds 181a1ud android-sdk r10-windows.zip 1Hmsuan

Tsesuanlndsuiluazdeaiilisunsy WinRAR %30 Winzip) leasnisaanuni v

android-sdk r10-windows.zip 180 “Extract Here”

31

android-sdk_rl0-
windows

A (Y 1 d = 3 ’
1 0. 44 Areenalvla android-sdk_r10-windows.zip



5) oy uan vld android-sdk r10-windows.zip &7 928 Folder ¥0 “android-sdk-

g 2 2 g < :
windows” 15109V @11 Folder 1A Android SDK

android-sdk-win
dows

1'7‘:1 f. 45 ﬂ’J’é)Eﬂ\‘i Folder mmn"lﬂaaaﬂmum

6) 11 Folder usn dvoniuda 11/la131u Folder 1R@1AY Eclipse IDE @901

{ . andraid-sdk-windows

2/18/2011 3:33 AM

.. configuration
L. dropins

. features

3/5¢2011 11251 PM
6/17/201010:39-AM
271972011 2:45 AM

.p2 271972011 2:18 AM
. plugins 2/19/2011°2:45 AM
W readme 2/19/2011 28 AM

| .eclipseproduct

12/10/2008 5:05 P

=% artifacts 2/19/2011 2:45. AM
= eclipse 2/8/2010 4:07 P
5 eclipse 2/19/2011 2:56 AN
5 eclipsec 2/8/2010 407 PP
& eplvio 2/25/2005.6'53 PM
& notice 472742010 3:23 PM

gﬂﬁ . 46 ﬁ]!mﬁQ’JN Folder Y94 android-sdk-windows
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7) QWﬂHHLﬂﬂ\Ma eclipse.exe YUN  LABDNLNY Window -> Preferences

| ( Window] Help

New Window

New Editor
Open Perspective 4
Show View »

Customize Perspective...
Save Perspective As...
Reset Perspective..,

L Close Perspective

x, Close All Perspectives
MNavigation 4

Android SDK and AVD Manager

Preferences

gﬂﬁ N. 47 1Y Window -> Preferences

4 Bl D 9 = T T Y A
8) Lil@ﬂﬁﬂlm@‘ﬂ$ﬂi1ﬂ§]ﬂu']ﬁ1@ Preferences UHNT SLHLNH@TH%WEJ?J@"U@QWU"I@N Ny

Android

- Preferences”\

I type filter text
General

Android

Lnt

Help

o
3UN n.48 1Y Android
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9) iiloiniuy Android ud2 92115109 Android Preferences NIAIUYNVBININAN  1AZil

SDK Location taas0g 1¥nsondoyaves Folder android-sdk-windows lagaantju( sowse.. |

& GL ' A F v a ‘ﬂ 0K Ay a a il
1D Lef SDK Location t38U388LLA7 AANTY | I9aIN13enian nany
Cancel }
Android Preferences
SDK Location: Browse,..
Mote: The list of SDK Targets belows is only reloaded onice you hit ‘apply' or 'OK',
Target Mame Vendar Platform APL ...
IRestore Defaults | | Apply ]
OK ] [ Cancel ]

v ey
31l 0. 49 ladwmiia Android SDK

10) 1A 2NNy Window -> Android SDK and AVD Manager

Window | Help

MNew Window

1 MNew Editor

Open Perspective

Show View

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective

Close All Perspectives
Navigation

i Android SDK and AVD Manager

Preferences

e e

gﬂ‘ﬁ f. 50 1Ny Window -> Android SDK and AVD Manager
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11) %‘]J‘i?ﬂg]ﬁ‘fﬁ Android SDK and AVD Manager ﬁmgﬁ'm%’mﬁaﬂ Available packages

Lﬁamaﬁwaﬂ Android SDK Tools

dienanudlnziliingdoyavod Android Package 9

o 2 { . ] . g’l a ]
ansaani maald adnfigesdmasumnil Android Repository 91nHUAANTY

Android SDK and AVD Manager

Description
i Android Repository

Virtual devices SDK Location: C:\eclipse\android-sdk-windows\
Installed packages e
Available packages || Packages available for download

Android Repository

71 ¥ Android SDK Tools, revision 10

i} Android SDK Platform-tools, revision 3

" Documentation for Android SDK, API11, revision 1
DK Platform Android 3.0, API11, revision 1

5 SDK Platform Android 2.3.3, API10, revision 1

nSiten. | [¥]Display updates only Install Selected

|| Add Add-on Site... Phelefed dcves

Y ° v d o
51 0. 51 vvhuaas Android SDK Packages d11i3uanulvaniisriag

a EY

12) dendnuda zilingvind1ufion Package 1113 Install

Package M@0313 Install 18 1ilodenGoudooudanantju
A, Y a A = i
Install Package ¥139A0IN158NMANNITLIADN Package ﬂﬁﬂﬂn

~ -
Choose Packages to Install

Tasmsaaonnnie

WoIFUNINg

Packages

|s fndroid SDK Tools, revision 10 7],

~ Documentation for Android SDK, API1L, r...
~ SDK Platform Android 3.0, API11, revision 1

~ Samples for SDK API 11, revision 1

~ Android SDK Platform-tools, revision 3 I’:] £

~ SDK Platform Android 2.3.3, API 10, revisio... |

Package Description & License

Package Descriptian
Android SDK Tools, revision 10

This update will replace revision 7 with revision 10.

Dependencies
Installing this package also requires installing:
- Android SDK Platform-tools, revision 3

This package is a dependency for:
- SDK Platferm Android 3.0, API11, revision 1

CAV Niatfrvmn Ancdenid 13D ADTIN cavirinn 1

@ Accept () Reject ) Accept All

[ Install ] [

Cancel

51/ 0. 52 189N Android SDK Packages 124M3 Install



N. 5 M3 Set Path Android SDK

1) AANYN My Computer Lﬁ’é)ﬂml‘g Properties

Open
Manage

Map network drive...

Disconnect network drive...

Create shortcut ‘
Delete f

Rename
Properties |

gﬂﬁ . 53 My Computer -> Properties

2) @115 Windows Vista #3® Windows 7 iananualvsalsingriiwaasdoyaineiny

a J a
ADUNAUADT ~MuTevaIniudAIToya AaNHoNWY Advanced system settings

» Control Panel » System mdSécuri 4 em
B, eii Ol

Control Panel Hol . W . ¢
| View basic information about your computer

| %' Device Manager Windows edition
#' Remote settings Windows 7 Ultimate
! System protection Copyright © 2009 Microsoft Corporation. All rights reserved.

@y Advanced system settings

a ] v A d
31]71 . 54 HUULAOAIVDHAVDINDNN UMD

94



3) iondnmyuds 921510 e System Properties 114 Tab Advanced AanTjy

[ Environment Varables... ]

System Properties

| [Computer Nae | Harduare | Advanced | System Potection | Remote |

You must be logged on as an Administrator to make most of these changes.

Performance
Visual effects. processor scheduling, memory usage. and vitual memory

]
User Profiles f
Desktop settings related to your logon ’

2 Startup and Recovery
System startup, system failure, and debugging information

l Settings...

Environment Variables...

gﬂﬁ f. 55 # System Properties -> Advanced

Y
4) MnHug1ls1ngnIi1 Environment Variables 1171984 User variables aaniju

DLW Variable

Environment Variable: w
User variables for Tanawat
Variable Value
TEMP %USERPROFILE%:\AppData\Local \Temp
T™MP %USERPROFILE % \AppData\Local \Temp
New... | (2 Edtoy [ osengd]
System variables
|
Variable Value 2 {
asl.log Destination=file y
‘ CLASSPATH .;C:\Program Files (x86)\QuickTime\QTS... :
ComSpec C:\Windows\system32\cmd.exe l
FP_NO_HOST_C... NO |
[ New.. J[ Edt. |[ Deete |

gﬂﬁ . 56 Tiﬁ] Environment Variables
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A a Y 9) =iy 1 g a9 a Y gl,/
5) waaanuan ‘ﬂgﬂiWﬂ{]‘Viu'lﬁNEJ@EJ New User Variable Iﬂﬂmﬂlﬂﬂgjﬁ%ﬂ@ﬁﬂiﬂﬂﬂﬁﬁuﬂ 2

AN U ﬁ@ Variable name la “PATH” 1@y Variable value la ‘ﬁ’e)gJ:“U’eN android-sdk-

. d' 9 a Y 9 = ' = S of
windows\tools tionsontayaivuioouda adnify 13 081ADINTEAAN
et
[ramepate. ——

Variable name: PATH

Variable value: C:\edlipse\android-sdk-windows\tools;

[ OK l [ Cancel

A Yy y
31]1’1 . 57 Y1319 Variable U839 User

7 A 2 U 9 A, 1 A
6) 113 1nq Variable ¥© PATH Y11 IU User variables ﬂﬁﬂﬂﬁJ e
v ' '
(Y a 4 = a 1 A a
403 9 UN TN User variable  Vi3oaanijy Cancel INDENLAN
Environment Variables ., $ o i “q,p s w

User variables for Tanawat
E Variable Value }
| PATH C:\edipse \android-sdk-windows \tools; |
| TEMP %USERPROFILE %\AppData\Local\Temp |
x TMP Y%USERPROFILE % \AppData'\Local\Temp

[ New... J s Editess < | [ Delete }
System variables
EFVariabIe Value - ’
| s =
| asl.log Destination=file '—J‘
| CLASSPATH .;C:\Program Files (x86)\QuickTime\QTS... ‘
| ComSpec C:\Windows\system32\cmd.exe
| FP_NO_HOST_C... NO -|

New.. ][ Edt.. |[ Delete |

i e

gﬂﬁ . 58 ‘Yiﬂ] Environment Variables %a39103 Variable uan



g’; [ d‘ 9 1 i a 1
7) NNUUITNAVNINKUINN System Properties ﬂﬁﬂ’iJiJ

System Properties

| [Computer Name | Hardware [ Advanced | System Protection | Remote
| |

You must be logged on as an Administrator to make most of these changes.

Peformance
Visual effects, processor scheduling, memory usage, and virttual memory

User Profiles
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